HUMAN RESOURCES

RELEASE NOTES — MARCH 2017

This document explains new product enhancements added to the ADMINS Unified Community for Windows
HUMAN RESOURCES system.
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ADMINS Unified Community
Human Resources

Release Notes — Version 17.1
March 2017

1. MAINTENANCE P EMPLOYEE MAINTENANCE ) [DATES/CLASS] TAB

When adding a new position to an existing employee, only the original hire date (EEO/Orig Hire Date) was
brought into the new position [Dates/Class] tab.

Employee Maintenance Employee Maintenance

oo
= Employee Mumber  RRERE  KEITH SAVOIE JR geto Employee Number  RERERE  KEITH SAVOIE JR
Actions Position 210POLSGT -05 POLICE SERGEANT 10f1 __H A Position 210POLLT  -02 POLICE LIEUTENANT 107 2 E|

Lkl Employes
P Adet Postion

1 Contact 2 Personal 3DeciBen | 4AddWages S Payroll 6 Accourting 7 Salary 2 Dates/Cla|

Emplovee

Date of Birth

Date of Death

Date of Martiage
Fingerprint

Physical Completed

Age
06-Mow-1953 57

Last Processed

Last Payrall 27-Feh-2017
Last Perfect Attendance
LastAnnual Attendance

Other

Leave of Absence Start
Leave of Absence End
Adjusted Seniority Date
Tenure Date

Position Dates
Date Applied
Offer Date
Fosition Hire Date
Anniversary Date
Longevity Date

LOS

——

——
51*_1\.41*1995 Wril? Mo:B Dy:l3
E5-5ep-1586

2-May-1988 Yri28 Moil0d Dyil2

Probation End Date
Retirement Date
EEQIOrig Hire Date
FT Date

Final COBRA Date
Layoff Date

Recall Date

CT PT Sick Leave Date
Evaluations

Date of Last Eval
Date of Mext Eval

i2-May-1988 fr128 Morld Dyil2
2-May-1988 fr128 Morld Dy;l2

pa-tay-1388

LAdd Employee
P Ad Postion

1 Contact 2 Personal 3DedBen | 4AddWages S Payroll 6 Accounting 7 Salary BDEtESIC

Employee
Date of Birth

Date of Death

Date of Mariage
Fingerprint

Physical Completed

Last Processed

Last Payrall

Last Perfert Atendance
Last Annual Atendance

Other

Leave of Absence Start
Leave of Absence End
Adjusted Seniority Date
Tenure Date

Age
0E-Hoy-1959 57

—
—

Position Dates
Date Applied

Offer Date

Position Hire Date
Anniversary Date
Longevity Date
Probation End Date
Retirement Date
EEOICrig Hire Date
FT Date

Final COBRA Date
Layoff Data

Recall Date

CTPT Sick Leave Date

Evaluations
Date of Last Eval
Date of Mext Eval

LOS

1-Mar=2017 Yri Mo: Dyil3

© oMor Dyi13
1-Mer—2017

12 1988 Yri28 Mo:il0d Dy:l2
1-Mar—2017 Yri Mo: Dyil3

—
—

Figure 1 Before — the new position only carried forward the EEO/Orig Hire Date

With the software update the option is now available to set the position hire date but retain some/most of the others.

1.1. Carry Forward Position Dates [New Option]

Any field may be typed over and replaced with a date of your choosing on this
screen when creating a new position. Overtyping dates may result in unintended
consequences when reports or queries are run.

Employee #310 is taking an additional position as the

v EpleEe WEIETEREE Fleet Maintenance Supervisor. Click on [P Add Position].
= Employee Number & B] MICHAEL AYOTTE JR

Acti Position B01POLAUX -0& AUKILARY POLICE 101 =

ions —
EM [AUC] 6445-Employee Maintenance [theresa]
A E) Add Position to Employee
W22 el Required: Enter Position |[Ey YW za]] [POLICE FLEET MAINTENANCE COORDINA

1 Corttact 2 Persanal 3DedBen | 4AddWages 5 Payroll £ Accourting 7 Salary 2 DatesiCi

Emplayee age| Position Dates LoS Lookup I oK | Cancel | Clear All |

Date af Birth 24-Mar-1945 71| Date Applied

Date of Death Offer Date

Date of Marriage Fosition Hire Date 1-May-1995 ¥ir:21 Mo:10 Dy:ls =

Fingerprint Anniversary Date Pl 195 M [AUC] 6445-Employes Maintenance [theresa] [ ]
Physical Completed Langevity Date 1-Hay—1995 Vr:21 Mo:l0 Ty:i5 Add Position to Employee

Probation End Date q o p
R d: Enter B Unit - i

Last Processed Retirement Date AL e INON NO IN" Ecncfits

Last Payroll 08-Dec—2015 EEQOrig Hire Date 1-May—1995 ¥r:21 Ma:10 Dy:ls Required: Enter Schedule [PT [Part Time non union

Last Perfect Aftendance FT Date 1-May-1995 Yr:21 Mo:l0 Dy:lS Required: Enter Grade l-l—

Last Annual Attendance Final COBRA Date

Layof Date Required: Enter Step 2

Other Recall Date Required: Enter Full-Time Equivalent

Leave of Absence Start CTPT Sick Leave Date 4 . ) g 5

Leave of Absence End Evaluations Required: Enter Date of Hire (nmddyyyy] |03012017]

Adjusted Seniority Date Date of Last Eval

Tenure Date Date of Mext Eval

PRI o ploe g 7=t et

. - . Lookup I oK I Cancel Clear All
Figure 2 Original Position Dates
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EN salary Information for 1.00 FTE [ %]

Annual lm—
Period |2|]4|]—
Daily |2|]4|]—
Hourly IW
Per Diem IW
Tier |1_

Optional: Copy DEDUCTIONS from this position

Optional: Copy DATES from this position

Nl [~UC] 6445-Employee Maintenance [theresa] [x]

Copy Deductions, Additional Wages and Dates from Existing Po

March 2017

Enter the Salary Information. The next prompt was updated to allow
DATES to be copied from a previous position.

Optional: Copy ADDITIONAL WAGES from this position |

[T801POLAUX -06

Cancel | Lookup I 0K

Cancel | CIearAIIl

IAUXI LARY POLICE

If the “Copy DATES from this position” field is left blank, the Position Hire, Anniversary, Longevity, Probation
End, EEO/Orig Hire and FT Dates will be set to the Position Hire Date. If a position is selected, the dates from the

selected position are copied into the new position.

The dates that will be copied (if present in the selected “old” position) include:

Other Position Dates
Leave of Absence Start Anniversary Date
Leave of Absence end Longevity Date
Adjusted Seniority Date Probation End Date
Tenure Date EEO/Orig Hire Date
Final Cobra Date
Layoff Date
Recall Date
CT PT Sick Leave Date

Evaluations
Date of Last Eval
Date of Next Eval

Eligible for...
Medicare

Retirement

Pension

Sick Bank

Civil Service (Seniority Date)
ERI

Perfect Attendance

Union Dues

Custom Dates

(Ten are available and will vary
depending on options selected on each
site)

[MBE-SUP-SAPLAUC-402]
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2. PAYROLL PROCESSING

The file created for Automated Clearing House processing (ACH) as part of payroll processing is now separating
the “PPD” records from the “CCD” records. A single file will be created but processed as distinct batches by the
Automated Clearing House. Select Human Resources P Payroll Processing P Process Paychecks P Create Direct
Deposit File:

Process Paychecks
Batch 1556
Description Date
Hurnan Resources Select and Caloulete Warrarts. 07-Feh-2017

Maint 5 Payroll Register 07-Feb—2017

EmEE=E Site Payroll Reports - OPTIONAL
Payroll Processing ld  ‘Warrant/Create Timeshest Screen Check Register O7-Fek-2017
Timesheet Entry 3 — i Frint Checks 07-Feb-2017

rocessin 7 ]

Special Processing 3 Y | — g’m gtemémgfn i il

. ) y 08-Feb-2017
Woid/Manual/Figure Paycheck Release Timesheets by Graup EGIEME EROSAILAE E
Billing and Invoicing 4 Release Timesheets by Warrant Post Lakor Distribution/Email Acdvices
Bark Reconciliation » /
o »  Process Paychecks «==] Greste R check Dovniond e | 07-Fer-p0i7

2.1. Create ACH File [Fix]

When using the SEC code PPD customers have 60 days to dispute or return the item as unauthorized. When using
the SEC code CCD customers have 48 hours to dispute or return the item as unauthorized. In the image below, the
payments to Vantage and the Bank of New York were not identified as “CCD” (commercial) records.

PEOPLE'S BANK TOWN OF
PPDPAYROLL 1221172180000001

VANTAGE TRANSFER AGENT ©221172180000554
THE BANK OF NEW YORK M ©221172180000555

Figure 3 Before

Now, the Commercial records are correctly identified, as shown in the image below:

.PECPLE'S EANE TOWN OF
PPDPAYROLL 170207170208 1221172180000001

CCDPAYROLL 170207170208 1221172180000002
ICMa RETIREMENMT TRUST 0221172180000000
ICMA RETIREMENT TRUST- 0221172180000002
WANTAGE TRAMSFER AGENT 0221172180000003
ICMA RETIREMENT CORP 0221172180000004

Figure 4 After

[ADM-AUC-HR-9875]
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3. VOID/MANUAL FIGURE PAYCHECK SCREEN [FIX]

When adding a void or manual check, and using the optional Employee Shift Code Override field, the system
allowed typing lower case letters into the find or search box. This resulted in no matching record found. Now the
system forces any find or search term to all caps so that the matching code will be found.

Manual Entry-Timesheets

[N [AuUC] 6201-¥oid /Manual;/Figure Paycheck [theresa]

Add Manual
Required: Enter Employee#f II]I]?I 29 |CACI, LAWRENCE M.
| Required: Enter Position |S|]I]BCUSMAIN—I]3 EI:Shits =

Required: Enter Beginning Date [mmddyyyy] |1 7-Jan-2017

Code lescription #lays PayCodel Hoursl Daysil TﬂfJ

Required: Enter Ending Date [mmddyyyy] |1 7-Jan-2017 LR .7 FTE 7 DREG 0 ﬂ
q q 9.5 HRS m 10,52 t.w.th 82 fr § 7 REG 5.00
Required: Enter Pay Period IN— No Time Rz SclaysShour e
Optional: Enter Employee Shift Code Override li HHT MONAHED THURS 6HR 7 REG 6.00
DIR-PT part time athletic direct 1 ADIR 1,00
RT .5 TUES ALL FRI 7
195 REGULAR 19.50 HOURS 7 REG 4.00
AKER Baker reg hoursdadmin pay 14 REG
FHL Brunelle Inspec Cl 7
Lookup 0K Can [BUS bus monitor 19.5 hours 7 BUS MTR 4,00
~— [BUS 15.5 bus monitor 15.5 hours 7 BUS MTR 4,00
US 17,5 Monique Killior— 17.5 hr 7 BUS MTR 4,00
us 2 Bethany Hamm— 2 hr per we 7
19 CONS19 HRS 7 REG 7,00
AFE OVT cafe 6.5 reg with 5 ovt 7 REG 5.50
AR ADJ Car Allowance Year end Ad 1 LI
OK | Find | Search| cancel| Help | Eof

LM Lookup Find [ %]

Find Shift Code beginning with:

[pisA

[ADM-AUC-HR-9857]
4. REPORTS
Access reports by selecting Human Resources » Reports » Report Library.
4.1. Employee Reports
Select Human Resources P Reports P Report Library P [1 By Employee] to select from the list of reports based on

employee data. The 6770-Employee Salary Difference Report now offers the option to enter a minimum employee
salary amount:

Property of ADMINS, Inc. No unauthorized use, distribution or reproduction permitted. Page 5 of 15
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Optional: Enter Employee#
Optional: Enter Bargaining Unit |

Task 6770: Employee Salary Difference Report

Employee Salary Difference Report

Preview i::[}'?rint PDF

| Lookup | | 0K | | Cancel ‘

[ Clear All

]
Report Library By Employee
Report Hame
A650-Enanl ouslRostes Schy Samale
L oA Run as O
5: 31-Emplogyee List — MWorkers Comp Code SEMHE
6732-Employse Skill Profile Card Sample
5149-Emplouse Salary Historu Change Rewort Sample
| B770-Employse Salary Difference Report Sample
BESY-Ei PO ERt VEFLFICatIon REpOTT Sample
| F500-Emplogee List — Custom Fields Sample

Figure 5 Before

Opti

I: Enter Empl

[N Task 6770: Employee Salary Difference Report

Employee Salary Difference Report

Run as @& Preview ¢ Print

If Printing use Duplex & ves

p

3
¥

Optional: Enter Bargaining Unit |

Optional: Enter Minimum Employee Salary Amount |5|]|]|]|

" PDF
" No

Lookup | 0K I

Cancel

C

lear All

Figure 6 After

4.1.1. 6770 Employee Salary Difference Report [Enhancement]

Using the minimum employee salary amount suppresses reporting on part time employees with varying hourly
rates and focuses on employees with variances that may impact budgeting.

6770-HREMP3ALDIF.REP Printed 13-Feb-2017 at 15:51:29 by THERESA Page 1
Towm of ADMING
Employee Salary Difference Report
Bargaining Unit: AFL -AF School Ueekly 12 month employees
Euployee Profile Bargaining Unit Salary ----------------n
Employee Position Schedule Grade Step Annual Period Daily Hourly Per Diem annual Period Daily Hourly Per Diem Sched. Date
002612 PLOUFFE, LAWRENCE S003CUSHEAD-03 CU 1 3 49, 441.60 950,60 190,16 23.7700 130180000 52,416.00 1,008.00 201.60 25.2000 201.600000 01-Jul-2016
003094 DALPE, MARIE S009BUSPAY-01 CLLZ 1 3 42,078.40 B809.20 161.84 20.2300 lel.840000 44,595.20 B57.60 171.52 21.4400 171.520000 01-Jul-2016
004009 HARPIN, LYMN 5 S0085PDCLEE-0Z CLLZ 1 4 44,925.00 864.00 172.80 21.6000 172.800000 47,632.00 816.00 183.20 22.9000 183.200000 01-Jul-2Z016
004084 GABOURY, MARIE R S006SCHCLRE-01 CL12 1 2 41,246.40 793.20 158.64 19,6300 158.640000 43,7z1.60 840,80 168.16 21.0200 1648.160000 01-Jul-2016
008006 CARRIERE, LAWRENCE L S006CUSLSTS-01 CIO 1 4 44,387.20 B853.60 17n.72 21.3400 170.720000 47,049,860 904.80 180.96 22.6200 180.960000 01-Jul-201&
006036 DROUIN, MICHAEL S004CUSHEAD-03 CIT 1 6 49,441.60 950,60 190,186 23.7700 1%0.160000 52,416.00 1,00&.00 z01.60 25.2000 201.600000 0l-Jul-2Z016
006099 BUSSAGLIA, MICHAEL F. S006CUSHEAD-07 CUO 1 3 49, 441.60 950,60 190,16 23.7700 130180000 52,416.00 1,008.00 201.60 25.2000 201.600000 01-Jul-2016
008137 KELLY, KEITH S00SCUSHEAD-0Z CIX 1 6 49,441.60 950,80 190,18 23.7700 190.160000 &2,416.00 1,008.00 201.60 25.2000 201.600000 01-Jul-2016
007008 AMBLER, LAWRENCE ¥. S01ZCUSLSTS-01 CO 1 4 44,387.20 B853.60 1.7z 21.3400 170.720000 47,049.60 804.80 180.96 22.6200 180.960000 01-Jul-2Z016
007037 CHUPA, KAREN P. S006CUSZNDE-02 CU 1 4 44,387.20 §53.60 170.72 21.3400 170.720000 47,043.60 904,80 180.96 22.6200 180.960000 01-Jul-2016
007045 GERRIOR, LAWRENCE R. S1B9CUSMCUS-01 CIT 1 4 44,387.20 B53.60 170,72 21.3400 170.720000 47,049,860 904.80 180.96 22.6200 180.960000 01-Jul-2016
These employees are excluded when the report is run with the optional minimum salary amount:

T7045T FEED, MARTE E TOZSTMESCH-0T SHE CAMP T T5. 0T T 0T T 0T TE.onon 15, 000000 () (I Ui 0. 40 T 3000 T Z00000 O0T-Tal-Z0TE
070464 LISTER, KAREN D TzZS51INSCLEE-OL PT 1 1 10.00 10.00 10.00 1l0.0000 10.000000 25.50 25.50 25.50 25.5000 25.500000 01-Jul-zZ0l6
070468 RYAN, MICHAEL J TE30PRESEAS-01 PARE 1 3 3,200.00 400.00 80,00 10,0000 2Z.860000 3,264.00 40&.00 8160 10,2000 Z23.310000 01-Jul-zOlé
070469 COLLINS, LAWRENCE G TE30PRESEAS-01 PARE 1 3 3,200.00 400.00 80.00 l0.0000  22.880000 3,264.00 408. 00 Bl.60 10,2000 23.310000 01-Jul-Z016
070476 BRIGHAM, FAREN J SO00SEXTSUMR-01 ESY PRGN 1 5 25.00 25.00 25.00 25.0000 25.000000 25.50 25.50 25.50 25.5000 25.500000 0l-Jul-zdle

4.2. Timesheet Reports

[ADM-AUC-HR-9873]

Select [3 By Timesheet] to view the list of reports based on timesheet entry and history. An Excel version of the
Timesheet Entry Detail by TS Group/Employee report was fixed to align the column headers with the data.

Property of ADMINS, Inc. No unauthorized use, distribution or reproduction permitted.
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4.2.1. 6220-Timesheet Entry Detail by TS Group/Employee [Fix]

[l_T.I' L‘;_-‘ ) - 1= T5_Detail_Employee_6220_THERESA
Home Insert Page Layout Formulas Data Reviewy Wier
a2 - S| 010287
) B & L E F &5

1 Emp# HName Position# Work Date Warrant Pay Code Description Expense Account

5 Bioze7 BERGERON, MICHAEL K SO0GTEAHIST-03 17-Jan-2017 201701 DREG REGLLAR - days

6 D1o2s7 BERGEROM, MICHAEL K SO0BTEAHIST-03 18-Jan-2017 201701 DREG REGULAR - days

7 D1o2s7 BERGERCHM, MICHAEL K SO0GTEAHIZT-03 19-Jan-2017 201701 DREG REGULAR - days

& Biozer BERGERCHM, MICHAEL K SO0GTEAHIST-03 20-Jan-2017 201701 DREG REGLULAR - days

g fozar BERGERON, MICHAEL K SO0GTEAHIST-03 23-Jan-2017 201701 DREG REGULAR - days

10 @1 0287 BERGERCH, MICHAEL K SO0GTEAHIZT-03 24-Jan-2017 ?01 bl DREG REGULAR - days
Figure 7 Before
Al .ﬂ ) - = T5_Detail_Emplowvee_6220_THERESA[3]xml - Microsoft Excel

Home Insert Page Layout Faormulas Data Review: e
125 M F
A B & D E F 2] H | J 3

1 Emp# Hame Position# Work Date Warrant Pay Code Description Expense Account Hours Days Wages Paid
2 10257 BERGERON, MICHAEL K SO0BTEAHIST-03  01-Feb-2017 830004 DWaAC ‘Wacation - Days 1000-300-2305-110-06-00-51260 TEACHER SALARY - HE 1.00 26617
3 10257 BERGEROM, MICHAEL K SOOGTEAHIST-03  02-Feb-2017 'B30004 DERV Bereavemert - Salari 1000-300-2305-110-06-00-51260 TEACHER SALARY - HS 1.00 26617
4 10257 BERGERON, MICHAEL K SOOBTEAHIST-03  03-Feb-2017 930004 DWUR JURY DUTY - SALARIED 1000-300-2305-110-06-00-51260 TEACHER SALARY - HE 1.00 26617
5 10267 BERGEROM, MICHAEL K SOOGTEAHIST-03  06-Feh-2017 530004 DREG REGULAR - days 1000-300-2305-110-06-00-51260 TEACHER SALARY - HS 1.00 26617
& 10257 BERGERON, MICHAEL K SO0BTEAHIST-D3  O7-Feb-2017 "30004 DREG REGULAR - days 1000-300-2305-110-06-00-51260 TEACHER SALARY - HE 1.00 1,597.01

Figure 8 After

5. TABLES

[ADM-AUC-HR-9867]

5.1. Cost Code Table [New] “Subtract (from W2)” Field Added

Cost Code Table

’ CostCode [ETiuaeny EO+ CATCH-UP COMTRIBUTION
[ cae
| - au
W2 Box# iz W2 Description E Appliesta: ¢ Beneft @ Deduction ¢ Bath A
1099-F Box # Applies to: " Beneft " Deduction © Both @ hip

Figure 9 Before

Cost Code Table

| Cost Code  [ISOKCONT ﬁVEREOK EMPLOVEE CONTRIEUTION

=8

Ne

© Deduction? Bath

1099-R Box#

Appliesto; € Benefit

- _,
I co. . olatement Categary | Separate - .ouk s
W2 By # 12 W2 Description £ Appliesto; @ Beneft ¢ Deduction? Both

Subtract % Yes C No

Subtract the amount from the
W2 box instead of adding it.

Figure 10 After

In most instances, cost code deductions or
benefits are added together to be reported
on the W2. In the case of over 50K life
insurance, the employee’s contribution
reduces the taxable benefit.

To accommodate this reduction in the
taxable benefit, the Cost Code Table has a
new field at the bottom right in the W2
box section. To denote this, set the
[Subtract] radio button to “Yes”. The
employee contributions will be deducted
from the benefit amount shown on the
W2.

[ADM-AUC-HR-9883]
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6. YEAR END

This section addresses items found under Human Resources » Year End Processing.

Human Resources
Maintenance 4 |
w Year-End PrD-:essing W2 Register Repart
MoGUiE MEMTENEnEe e W2 Register by Warrant
Interfaces/Imports 3 W2 Processing
Site Specific 3

Form 945 - Federal Annual Report
Help Reference Library 1099 - R Register Report

1099 - R Register by Warrant
1099 - R Processing

List oF Crck Crdac by 42010900 Reo

res Reset Cost Code Annual Maximums

Bl

6.1. Reset Cost Code Annual Maximums [Fix] & [Update]

Use the Reset Cost Code Annual Maximums process to reset the remaining balance for employee deductions to the
amount of the cost code table annual maximum or the employee’s original amount.

During the reset process, items deselected were still posted, but not reported as posted. This has been resolved.

In addition, an option for cost code category was added to allow users to select up to nine cost code categories.

If there are many cost codes to be reset within a category use this option to select all the codes
for a given category.

M Task 6032: Create Cost Code Annual Maximum Reset File

Create Cost Code Annual Maximum Reset File

Optional: Enter up to 9 Cost Codes 0 values:
Optional: Enter up to 9 Categories Edit |[0values:

Upuate EMpIoyee ungimar AmounewinT costcone cmproyee Annual Maximum: 4 ves © No

Lookup 0K Cancel Clear All

[ADM-AUC-HR-9852]

6.2. Tool to Help Research and Resolve ACA Filing Errors [New]

The most frequent ACA filing errors are the result of TIN Validation failure due to a bad social security
number/name match. The link below allows employers to validate Social Security Numbers against names. This
link may be used when adding a new hire or covered individuals in the Human Resources » Maintenance »
Employee Maintenance P [V ACA Tab] to verify and validate the data.

https://www.ssa.gov/employer/ssnv.htm

Employees must verify their data for you by producing their Social Security card or a letter of confirmation from
the Social Security Administration.

[ADM-AUC-DOC-118]
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6.3. 1095C Processing Entity Table Screen [Update]

W2 Reqgister Report
W2 Register by Warrant
W2 Processing

1095 Processing

Description Date
1095 -  Emplovees with Reportable Health Caverage Rezet 1095 Meny. _ | 20-Jan-2017
1095 - C Expart Emplayes ACA Data P PayrollW21095-C |
1095 - C Employes Mame and Mumber Export TR

Bargaining Unit - Affordable Care Act
ACA 1095 Audit Report

1095 - C Impork Employes ACA Data
11095 Processing

6.3.1. Payroll W2 1095C [Entity Table Changes]

The Payroll W2 1095-C screen was updated to incorporate new changes to the law for tax year 2016 reporting and
installed on sites in January; this notice is included here to document the change.

1. The Plan Start Month requires a two—digit number between “01” and “12”—if the plan starts in January,
enter “01”, if the plan starts in July, enter “07”.

The HSA Plan check box, when selected, allows the values in Line 15 to be blank.

3. The description for Line 15 codes was updated to include Codes 1J and 1K.

N

Payroll W2 1095 - C Payroll W2 1095 - C

I entity [HEM Description [TON OF AHVAFERE ©1083-R W2 I entity [l Description [TOWN OF ANTWHERE C089R & o2
Mame [OWN OF ANYWHERE Name  [TOWN OF ANTHHERE
Address 1 [[_FAIN GTREET Address 1 [T FAIN GTREET
Address 2 Address 2
Address 3 Address 3
City  [CAMBRIDGE Phone (555) 655-5555 City  [CAFBRIDGE Phone (555} 555-5555
State f@ | Zip Code [(2138-0000 FedTaxID  [[1-3456789 State [ Zip Code pZ138-0000 Fed TaxID  [{1-3d567&3
countey [ State Tax D [111-111-1111 county [ State TaxID  [11-111-1111
1 Payroll W2 | ZPayrol AR 3 Payrol 10397 4 Payrol 10997 ACE 1 Payroll W2 | 2 EayrenzEE| 3 Payroll 1093.F, 4 Payrol 1085 ACA
ContactName ALY @, PUBLIC Phone  [(555y 3219876 Ed [123 GCantact Name [BALLY @, POBLIC Phone  [(B55) s21-9876 Bt [iZ3
ExportFile Path 2 \auc_developnent \achhone\transfer ExportFile Path  HiNauc_developmentadwhone’tr; er
Transmitter Control Code [EBFT Plan Start Month [T HSAPlan [~ Transmitter Control Code [BBEFT ﬁFlan StartMonth ot HSAP\E" ~
1094-C Line 22 (select all that apply): 1094.C Line 22 (select all that apply):
A Qualifying Offer Methad ¥ B.Qualifing Offer Method Transitional Relief [~ A Qualifying Offer Method ¥ B Qualifing Offer Method Transitional Relief [~
. Section 4880H Transiional Relief [~ D. 98% Offer Methad r C. Section 4640H Transitional Relier [~ D. 98% Offer Method

Coverage is Providsd Through a Selfinsured Plan? & Yes (' No  Employer Afiordability Safe Harbor [

Federal Poverty Line (FFL) Amount
1095-C Line 14 Overall Value:

All12 Months Jan Feb Mar Apr May Jun
E o
Jul Aug Sep Oct Moy Dec

Coverage is Provided Through a Selftinsured Plan? & Yes (" Mo Emplayer Affardability Safe Harbor [

Federal Poverty Line (FPL) Amount
1095-C Line 14 Overall Value:

All12 Months Jan Feb Mar Apr bty Jun
fE o [T r r r U r

Jul Aug Sep oct Mov Dec

1095-C Line 15 For Codes 1B, 1, 1D of 1E: 1095.C Line 15 For Codes 1B,1C,1D,1E, 1 or 1K \Ag:_
0

Ernployee Share of Lowest Gost Monthly Premium far Selt-Only Minurur Value Goverage Employee Share of Lo st Monihly Premium for Self-Only Minumum Value Coverage
All 12 Months Jan Feb Mar Apr Mhay Jun AIl12 Months Jan Fet Mar Apr May Jun
I o [ was[ w0 9r.a0[ o[ 101.%6[ 101,96 I or [ 525[  r.do[  9F.0[ 97,10 101,96 101,96
Jul Aug Sop Oct Nov Dec Jul Aug Sep Oct Ny Dec
[ 1oL.% [ 101,96 101.96[ 101.96] 101.96] 101,96

[ to1,%[ 101,96 101,96 [ 101,96 [ 101,56[ 101,96

Figure 11 Before Figure 12 After

[ADM-AUC-HR-9851]
6.3.2. Upload 1095C Data [Fix]
The upload process was not including all records in the spreadsheet. This was corrected.

[ADM-AUC-HR-9860]

Property of ADMINS, Inc. No unauthorized use, distribution or reproduction permitted. Page 9 of 15



ADMINS Unified Community Release Notes — Version 17.1
Human Resources March 2017

6.3.3. 1095C Forms — Social Security Numbers [Update]

.1095-C Employer-Provided Health Insurance Offer and Cove - 1095-C EEﬁB{'?gﬁ’;‘::ﬁ‘;‘){dgﬂ"kajjmi'ﬁ urance Offer and Cov
Department of the Treasury Information about Form 1095-C and its separate instructions is at ww.irs.gov/form e informztion 2bout Form 1035-C and its ssparats Instructions is at wunw.irs. gowTor:
Internal Revenue Service
Part1 | Employee Employee
001-10-1371 ) XXX-XX 8782
Figure 13 Before Figure 14 After

In Part 1 Employee information, the social security number was printing in its entirety. With the software update,
the social security number printed on the forms is masked and only the last four digits will print.

[ADM-AUC-HR-9880]

6.3.4. Bargaining Unit Table [Update]

A similar change was made to the [Affordable Care Act] tab of the Bargaining Unit Table:

Bargaining Unit - Al Care Act
‘ FEA 78 FBA For W Participarte
{CosiCodes | pHeidsys | 3largeviyPay | 4 | _SSeySched | _ Gomerinin | Bereft Statements| rend]
oven! Plan Start Month bt
siant HBAPIaN ~

HEAT

o5 1095-C Line 14 Overall Value:

All 12 Months | oo
or st oy Dec
. 1095
1095 Processing ) A —
1095-C Line 15 For Codes 1B,1C,ID,IE1Jor 1K: | swr May
- - S | ] ]
Description Date Jul Aun Sen ot hov Dac
Reszet 1095 Menu 20-Jan-2017
Ermployer AOrOaDillty Safe Harbor —
Payroll V2 1095 - C Federal Povrty Line (FPL) Amount  —
ACAFiling Table
Bar Bargaining Unit - Affordable Care Act
ACAT095 Audit Report |

6.3.5. Audit Reports [Fix]

The Employee Audit Report #3 was changed to properly describe social security number mismatches—the
explanation was updated and installed on sites in January; this notice is included here to document the change.

Employee: 009572 SUELTENFUI3S, LYNN &

Line 1 3%# iz not the Emplovyee 33§ niszing when first name set

Figure 15 Before

Enployee: 005872 SUELTENFUSS, LYHN &

Figure 16 After

[ADM-AUC-HR-9854]
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6.3.6. Who Gets a 1095C Form [Clarification]

The ACA filing is based on calendar year and the examples below are for the calendar year January 1, 2016 —
December 31, 2016.

Sites shall provide a 1095C form to:
e new employees taking health insurance in 2016
e employees previously declining and now taking health insurance in 2016
e employees continuing health insurance in 2016
e employees declining insurance in 2016
e employees with changes to covered individuals in 2016

If a continuing employee declined insurance prior to 1 January 2016, and has the offer to take insurance in 2016
but did not elect to take insurance with the municipality they are not reportable, as their declined status did not
change in 2016. They are reportable by the company providing their health insurance.

[ADM-AUC-HR-9887]

6.3.7. 1095C Forms [Update]

The 1095C form was updated per the IRS instructions and installed on sites in January; this notice is included here
to document the change.

Employer-Provided Health Insurance Offer and Coverage Employer-Provided Health Insurance Offer and Coverage
Do not attach to your tax return. Keep for your records.
Information about Form 1095-C and its separate instructions is at ww.irs.gov/form1095¢ Information aho:: Form 1095-C andEli]ls sepy;ram instructions is ateww.irs.gov/ fam 1095¢
Figure 17 Before Figure 18 After
T Employee Offer and Coverage ETM Employee Offer and Coverage
All 12 Months Jan Al 12 Months Jan
14 Offer of coverage (enter required code) 1E 14 Offer of coverage (erter required code) 1E
15 Employee Share of Lowest Cost Monthly 15 Employee Reguired Confribution (see
Premium, for Self-Only Minimum Value Coverage 0.00 instructions ) 0 00
16 Applicable Section 4980 Safe 16 Section 4920 Safe Harbar and
F e e e o e o] Otter Relief erer code, fapplicable ) 2C
Figure 19 Before Figure 20 After

[ADM-AUC-HR-9851]

7. SCREEN MINIMIZED ON TIMEOUT [FIX]

Users on selected sites were unable to restore an AUC session if the

il
{
?
|

screen was minimized and the time out limit was reached. With the
software update, restore an AUC session by double clicking on the
ADMINS icon in the taskbar

Double Click on the
ADMINS Icon in the
taskbar to restore
the session

[ADM-AUC-SY-8001]

Property of ADMINS, Inc. No unauthorized use, distribution or reproduction permitted. Page 11 of 15



ADMINS Unified Community Release Notes — Version 17.1
Human Resources March 2017

8. RECORD LOCKS [NEW]

e LR aaaae  Users sometimes encounter a lock that prevents them from accessing a record.
File Edit Ledgers PurchassOrders Accou  There js a message displayed at the bottom of the screen in the lower left corner
8| wlef+ m| E5 that will say “Waiting for Record Lock, User \IRIS\theresa”, for example. This
tells the user who else is on the record. Some users may be unable to see or
interpret this message and will ask an expert user at their location for help.

Gota. ..
Actions A new feature is available that an expert user on the site EE
. . 1=
may use to identify record locks. Select Help P Check 5p =
Blocking Locks. Eh
1 Akl New g Join Go To Meeting
ARt This will check for blocking locks and open a report Check Blacking Locks
window on the screen with the lock information.
3 Eddit List

! TedRE - locks_THERESA.lis
File Edit Format Options

oA A A A A A

ICDurierNaw j |11 j Bl[lgl-' _EI i= IEEE = @I
MLOCK -b

User "theresa" PID "00000el8" on node "IRIS" running "TRAN", has record 35
in file "d:“AUC_DE~1%admhome'auc\FMMODA\DatiTabk‘\apportrm.tab"” open for "Writ”
which is blocking "anthea™ PID "00000f28" on node "IRIS"™ trying to run "TRAN"

| v

W/ aiting For Recard Lock, User Y1IRIS theresa -

el

In the example, the user “Theresa” is blocking “Anthea” and the expert user may contact Theresa to ask her to exit
the screen to release the lock and allow Anthea to access the record. The expert user now must click File ] Exit to
close this report window before they can do anything else in AUC.

The user with a record lock will not be able to use the Help » Check Blocking
Locks feature since they are already captive in the locked AUC process. They will
need to ask another user, the site “super user” or ADMINS to check for them.

[ADM-AUC-SY-7995]

9. PREVENTING “FROZEN"” SESSIONS [NEW]

Occasionally, users report that their session has “Frozen”. To minimize the chance of this happening, always exit
the system using File » Exit from the menu.

192.762.168.24

Tax Motor Excise  Misc Biling  System

= [AUC] 27000-Ledgers Help Refe +H
File Edit Ledgers Purchase Orders Collections

Printer Setup... :lll'_’ll |

Prink

“Frozen” sessions may result if the X on the blue connection bar at the top of the screen is used to close the AUC
session, or if the session is abandoned at the end of the workday.
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Users who will be away from their desks for longer than 30 minutes should exit from the AUC application using
File P Exit from the menu prior to departing. Do the same at the end of the workday, as open sessions on the server
may result in unintended consequences.

[ADM-AUC-DOC-120]

10. MULTI-RECORD SCREENS [FIX]

Sites using version 9.2 of the ADMINS software were updated to use proportional fonts in the headings of multi-
record screens. This allows fixed fonts to be used for the data within the grids, which users report are easier to
read, while using variable fonts for the headings, fixing alignment issues.

O Excel by Date | 1 Accaunt I 2/ Pastinggt I Elzer Batch | 4 Feferenced I 5]
Trx Date Reference#| Line| GL#Tr=Cods| User Bat# Posting# Amount[Tuyed Display - “en

R i Ty

Figure 21 Before

g Excel —

9 Excel by Date | Accant | 2 Posting# | 3 User Batch | 4 Referenced | 5 Trx Date |
I|Tr>< Date References# Line GL#| TroZode User Bat# Posting# Amourd]Type || Dizplay - Wendor
ml L DLBHJ 1 Lo HUJ. ?35 28 L L ey S L
Figure 22 After

[ADM-AUC-SY-8002]

11. SYSTEM ADMINISTRATION KIT [UPDATE] PCL 5

Some printers advertised to be PCL 6 compliant do not include PCL 5 backward compatibility. When deploying
printers without PCL 5 backward compatibility, ADMINS recommends that the default for reports is set to PDF
printing.

11.1. Printers [PDF Option]
ADMINS recommends that sites select a default of “PDF” for reports. The only impact to the users will be the

report displayed in the PDF Viewer instead of the ADMINS Report Viewer (TedRE). If you want your site to
default to PDF output please contact support@admins.com to arrange for the change.

Q This is a site-wide change that will affect all modules and all users of AUC.

11.1.1. What Will the Users See?

EM Task 1610: Trial Balance M Task 1610: Trial Balance
General Ledger Trial Balance Report General Ledger Trial Balance Report
Runas @& Preview  Print  PDF " Excel Runas ¢ Preview (" Print « PDF " Excel
If Printing use Duplex & Yes  No If Printing use Duplex & ves ¢ No
Lookup | ok | cancel | Clearall Lookup | oKk | cancel | cicars
Figure 23 Preview as the Default Figure 24 PDF as the Default
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<% TedRE - GL_Trial_Balance_MUPDEY4[1].lis
T TETEST TN Ny

i! GL_Trial_Balance_MUPDEY4[1].pdf - Adobe Reader

P TSp—— - . G e

Figure 25 ADM Ted Viewer Figure 26 PDF Viewer

This default will not prevent users from selecting Preview. If a user tries to print the “*.lis” report output using the
TedRE Preview to a printer that is not PCL 5 compliant the report will not print. Selecting PDF will preview the
report in a PDF Viewer window and will print to any printer.

[ADM-AUC-SY-8008]

12. ADOBE ACROBAT PDF VIEWER SETTINGS [Update]

PDF is the default for ADMINS reports on some sites. When the report comes into view, you may customize the
appearance of the viewing window by pressing [CTRL|K] or selecting Edit» Preferences. From there, you may set
your default layout and zoom with the drop down menus.

rreferences
Categories: ~ Default Layout and Zoom
Commenting Page Layout: | Single Page 'I Zoorm: IF\tW\dth l
Documents
Full Screen —Resolution
General
1 Use systern setting: 96 pixelsfinch % Custom resalution: jal] ﬂ pixelsfinch

30 & Multimedia .

o ~ Rendeting
Accessibility
Farrns Smooth Text: IFDrLaptoprCD screens v
Identity
International ¥ Srooth line art ¥ Smooth images
Internet -
JavaScript ¥ Use local fonts ¥ Enhance thin lines

Measuring (20}
deasuring (300
Measuring {Geo)

[V Use page cache

rultimedia (legacy)

Multirmedia Trust (legacy) [ Page Content and Information
Online Services . 5
v
Resding ¥ Show large images I~ Use smooth zoaming
Reviewing [ Show art, trim, & bleed boxes [~ Show transparency grid
Search
Security [V Use logical page numbers [~ Always show document page size
Security (Enhanced)
Spelling Use Qwerprint Presiew: I Only For PDF/ Files 'l
Tracker
Trust Manager ~ Reference XObjects View hMode
Units
Updater Show reference XObject targets: I Only PDF/C5 compliant ones j

Location of referenced files: I Browse for Location..,
QK I Cancel |

[ADM-AUC-DOC-118]
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13. HELP REFERENCE LIBRARY

13.1. New or Updated Documentation

The following new or updated documentation was added to the Help Reference Library.
e EMPLOYEE POSITIONS HR-200 Reset Annual Maximums
HR-210 Leave Accruals
HR-275 Pay Codes
e SPECIAL PROCESSING HR-580 Year End Taxable Benefit Adjustments
e YEAREND PROCESSING  HR-630 W2 Processing Slides
HR-670 1099R Training Slides
HR-750 ACA January 2017 Webinar
e SYSTEM HR-1110 System Administration Kit

[Updated]
[Updated]
[New]
[New]
[Updated]
[Updated]
[New]
[Updated]
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